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Introduction 1
1 Introduction

1.1 Welcome
Thank you for purchasing a PagePro 1250E.

So you can use your new laser printer effectively and achieve the best
possible results, this manual provides you with information on the follow-
ing topics:

� Installing the printer driver

� Working with the printer drivers and tools

� Working with the printer

� Caring for and maintaining the printer

� Troubleshooting

Read this manual carefully before operating your printer for the first time,
and always keep the manual within easy reach.
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1 Introduction
1.2 Roadmap of this manual
The following table is designed to help you find the information you need.
Alternatively, to find information on a specific problem quickly and precise-
ly, refer to the index at the end of this manual.

No. Title of chapter Contents of chapter

1 Introduction Overview of this manual.

2 Setting up the printer Information on how to set up the printer as well as an
introduction to its features.

3 Installing a printer driver A step-by-step explanation of the procedure for
installing a printer driver.

4 Working with the Windows
PCL printer drivers

Overview of the Windows PCL printer drivers.

5 Working with the Windows
PostScript printer drivers

Overview of the Windows PostScript printer drivers.

6 Working with the Windows
printer tools

Details of how to use the Status Monitor and Printer
Control Panel.

7 Working with the Macintosh
printer drivers

Details of how to use the Macintosh printer driver to
control the printer.

8 Working with the printer General information on how to use your printer,
including supported media sizes and types, loading
media, monitoring print jobs, and canceling print jobs.

9 Installing printer options Detailed instructions on installing printer options:
lower feeder unit, face-up tray, and SDRAM-DIMMs
(Dual In-line Memory Modules).

10 Maintaining the printer Information on how to replace consumables and
clean the printer.

11 Troubleshooting Information on identifying and solving printer
problems.

12 Specifications Technical specifications, safety information, and
regulatory information.

Index Index of the contents of this manual.
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Introduction 1

Brief explanation of special type styles and method of presentation

Special type styles and methods of presentation are used in this manual
to highlight various circumstances. The following examples will help you
recognize and deal with the most important of these.

CAUTION OR WARNING

This is a caution or warning!
A caution alerts you to damage that could result to the printer by treating
it improperly while a warning alerts you to the potential for bodily harm.

➜ The arrow refers you to safety measures that must be taken to prevent
the hazard.

[MENU] button on the printer driver with the description “Menu”

➜ Single action to be performed (there are no other steps)

1 Step 1 of a series of actions

2 Step 2 of a series of actions.

? Help is available here.

➜ The approach that is suggested
here is sure to get you to your
desired result.

✎
This is a helpful tip
Text passages that are identified in this manner provide you with tips
and tricks that make it even easier to work with the printer.

Here you can see what has to be done.
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Setting up the printer 2
2 Setting up the printer

2.1 Overview of the printer

Exterior

3

11

12

4
5

6

8

9

7
2

1

10 13

No. Description No. Description

1 Top cover release button 8 Tray cover

2 Power switch (ON/OFF) 9 Tray 1 (universal tray)

3 Face-down tray (printed side down) 10 USB interface connector

4 Control panel 11 Parallel interface connector

5 Top cover 12 Face-up/face-down selection switch
(printed side up/down)

6 Paper guides for manual feed tray 13 Power cord socket

7 Manual feed tray
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2 Setting up the printer
Interior

1

2 3

No. Description No. Description

1 Fusing unit 3 Drum cartridge

2 Toner cartridge
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Setting up the printer 2

Optional accessories

1

2

No. Description No. Description

1 Face-up tray
(printed side up)

2 Lower feeder unit (Tray 2)
(500-sheet capacity)
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2 Setting up the printer
Printer control panel

The control panel has two indicators and one button.

For further information on the control panel, see page 8-4.

No. Description

1 Error indicator (orange)

2 Ready indicator (green)

3 Panel button

1

2

3
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Setting up the printer 2
2.2 Installing your laser printer

Place of installation

Set up the printer in a place that is

� dry and free from dust

� on a stable surface

� well ventilated

� near an easily accessible power socket

� away from objects which might obstruct the printer’s ventilation grille

� away from highly flammable items (such as curtains)

� away from splashing liquids

� away from organic gases (such as ammonia)

� away from direct sunlight

� away from severe temperature fluctuations

� away from exhaust-air from heating, ventilation, and air-conditioning
systems

Storage of consumables and accessories

Printing consumables and accessories should be kept

� sealed in their original packaging

� protected from direct sunlight or heat

� protected from fluorescent light

� in a cool, dry, and dust-free place

� out of reach of children

WARNING

Toner poses a health hazard!
Toner is harmful if swallowed.

➜ If you swallow toner, consult a doctor immediately.

➜ If you get toner on your hands, wash them immediately with cold water
and soap.

Ambient conditions

The optimum ambient conditions for your printer are as follows:

� Temperature range: 50°F–95°F/10°C–35°C with maximum fluctua-
tions of 18°F/10°C per hour

� Humidity range: 15%–85% with maximum fluctuations of 20% per hour
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2 Setting up the printer
2-6

Space requirements

Be sure to provide enough space around the printer to ensure easy printer
operation, paper and toner replacement, and maintenance.
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Setting up the printer 2
2.3 Setting up your laser printer

Loading paper in Tray 1

1 Remove the tray cover.

2 Squeeze the right media guide and
open the media guides.

3 Place a stack of paper in the tray.

? How many sheets may I place in
the tray?

➜ Tray 1 has a capacity of 250
sheets of plain paper. The stack
of paper should not rise above
the media limit mark.

? What if I am loading legal-size
paper?

➜ Open the cover at the front of
the tray.

4 Squeeze the right media guide and adjust the media guides so that
both the left and right sides of the paper stack are secure.

5 Replace the tray cover.

6 Open the face-down tray.
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2 Setting up the printer
❍ If you installed an optional face-
up tray and you want the sheets
to come out face up, then open
the face-up tray instead of the
face-down tray, and set the
face-up/face-down selection
switch as shown.

Loading paper in the manual feed tray

1 Make sure that the tray cover is properly attached to Tray 1.

2 Open the paper guides.

3 Insert a sheet of paper as far as
possible into the manual feed tray
with the side to be printed facing up,
and then adjust the paper guides so
that both sides of the paper are se-
cure.

? How many sheets may I place in
the tray?

➜ Load only one sheet of paper at
a time.
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Setting up the printer 2

Connecting the power cord

WARNING

Use only the power cord shipped with the printer. Using the wrong
power cord may lead to a short-circuit!
The use of a power cord of inadequate cross-section can lead to a short-
circuit.

➜ Only use an extension cable which has a higher rating than the current
consumption of the printer.

➜ Only use grounded cords.

➜ Always observe the relevant local regulations regarding the connec-
tion of electrical equipment to the main network.

This laser printer requires a non-fluctuating power supply. If necessary,
ask an electrician for advice.

✔ Voltage: 110V - 10%, 127V + 6%, or 220-240V ± 10%

✔ Frequency: 50-60Hz ± 3Hz

1 Make sure that the printer’s power
switch is in the “O” (OFF) position.

2 Connect one end of the power cord
to the power cord socket on the
back of the printer, and plug the oth-
er end into a power outlet.
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2 Setting up the printer
Turning the printer on and off

✎
Note
Improper handling may damage the printer!
- Never turn off the printer while a print job is in progress, the printer is
receiving data from the computer (blinking green “Ready” indicator on
control panel), or the printer is being reset.

➜ Set the power switch to the “I” (ON)
position to turn on the printer.

The printer is ready to use in ap-
proximately 20 seconds. The green
“Ready” indicator should be on (but
not blinking) and the orange “Error”
indicator off.

➜ Set the power switch to the
“O” (OFF) position to turn off the
printer.

✎
Saving energy is sensible!
When the printer has been inactive for a certain length of time, it auto-
matically switches to the POWER SAVE mode. This time period can
be adjusted via the Windows printer tools (see chapter 6).
When the printer receives a new print job while in POWER SAVE
mode, it automatically switches to the warmup phase and is ready to
print within 7 seconds.
2-10 EDNord - Istedgade 37A - 9000 Aalborg - telefon 96333500



Setting up the printer 2

Printing a configuration page

After you have set up and turned on the printer, you should print a config-
uration page to ensure that the printer is operating correctly.

1 Make sure that

❍ the orange “Error” indicator is off
❍ the green “Ready” indicator is on (but not blinking).

2 Briefly press the panel button.

❍ All indicators blink rapidly.

3 Press the panel button two more times.

❍ A configuration page is printed.

Panel
button
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2 Setting up the printer
Connecting the printer to a computer

Parallel interface (Windows XP/2000/Me/98/95/NT 4.0)

1 Turn off both the printer and PC.

2 Connect one end of the interface cable to the parallel port of the PC.

3 Connect the other end of the inter-
face cable to the parallel interface
connector on the back of the printer.
Secure the interface cable using the
two clips.

4 Turn on the printer and then, when
it’s ready, turn on the PC.

? Does the Windows operating
system detect the new device?

➜ If you are using Windows XP/Me/2000/98, plug-and-play printer
driver installation should start automatically. Follow the instruc-
tions on the screen. See chapter 3 for more information.

➜ If you’re using Windows XP/Me/2000/98 and plug-and-play driver
installation doesn’t start automatically, leave the printer on, unplug
both ends of the interface cable, and the reconnect the cable. If this
does not work, use the instructions in chapter 3 to install the printer
driver manually.

➜ If you’re using Windows 95/NT 4.0, use the instructions in chapter
3 to install the printer driver manually.

For technical specifications of the parallel cable, see chapter 12.

✎
Note
Using the wrong type of cable can damage the socket on the
printer.
- Use only an IEEE 1284 type B shielded interface cable.
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Setting up the printer 2

USB interface (Windows XP/2000/Me/98)

✎
Note
Windows 95/NT4.0 do not support USB connections.

1 Turn off both the PC and the printer.

2 Turn on the PC.

3 Turn on the printer.

4 When Windows and the printer are both ready, connect one end of the
interface cable to the PC’s USB port.

5 Connect the other end of the inter-
face cable to the USB interface con-
nector on the back of the printer.

? Does the Windows operating
system detect the new device?

➜ Plug-and-play driver installation
should start automatically. Fol-
low the instructions on the
screen. See chapter 3 for more
information.

➜ If plug-and-play driver installation doesn’t start automatically, leave
the printer on, unplug both ends of the interface cable, and the re-
connect the cable. If this does not work, use the instructions in
chapter 3 to install the printer driver manually.

For technical specifications of the cable, see chapter 12.

✎
Note
Using the wrong type of cable can damage the socket on the
printer.
- Use only a USB Revision 1.1 compliant cable for connecting the
printer to your computer.
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Installing a printer driver 3
3 Installing a printer driver

3.1 Minimum system requirements

Windows

� IBM-compatible PC with a Pentium 133 MHz processor

� Microsoft Windows XP/Me/2000/98/95/NT 4.0

� 64 MB of RAM

� 15 MB free hard disk space

� IEEE 1284 Type B parallel port or USB port

� CD-ROM drive

Macintosh

� Apple Macintosh computer with a PowerPC 604 processor

� Mac OS 9/OS X

� 128 MB of RAM

� 15 MB free hard disk space

� USB port

� CD-ROM drive
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3 Installing a printer driver
3.2 Notes on installing the printer driver

Don’t be afraid of the installation!

The installation program is designed so that even people not accustomed
to working with computers can easily install a printer driver. You will be led
step-by-step through the installation process. All you need to do is follow
the installation program.

Before you begin the installation, you should know the following informa-
tion:

� What operating system is running on your computer (for example,
Windows XP)?

� What is the letter of your CD-ROM drive (for example, D)?

� Which optional accessories are installed on your printer (for example,
a lower feeder unit)?

� Is your printer connected directly to your computer via a parallel inter-
face cable or a USB cable?

General information on the printer driver

The printer driver is delivered on a CD-ROM along with the printer.

✎
No CD-ROM drive?
You can download the printer driver from the Internet. You can find the
latest version of the printer driver at http://www.minolta-qms.com
(choose "Online Help & Drivers").

Information on installation using “Add Printer” (for Windows)

When installing the printer driver using “Start>Settings>Printer>Add Print-
er,” note the following points:

� The dialog box for installing options is not displayed. Adjust the addi-
tional options after you have completed the installation in the printer
driver.

� The Status Monitor will not be installed.

� The uninstaller utility will not be installed.

✎
Installing the PostScript printer driver
- The PostScript printer driver can be installed under Windows only by
using the Add Printer Wizard.
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Installing a printer driver 3
3.3 Installing the USB device driver (Windows)
When connecting the printer to your PC with a USB cable, install the USB
device driver according to the following instructions before installing the
printer driver.

✎
Windows 95/NT 4.0 do not support USB connections.

To install the USB device driver under Windows 98

1 Turn on your PC.

2 Turn on the printer.

3 When Windows and the printer are both ready, insert the CD-ROM
that came with your printer into your PC’s CD-ROM drive.

? What if the installation program starts up automatically?

➜ Close the dialog box by clicking the X in the upper-right corner.

4 Connect the printer to the PC with the USB cable (see chapter 2) to
display the Add New Hardware Wizard dialog box.

5 Choose [Next] to display the next dialog box.

6 Check the “Search for the best driver for your device. (Recommend-
ed).” option button, and then choose [Next].
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7 When the next dialog box displays, check the “Specify a location” box,
and then choose [Browse].

8 Browse the CD-ROM and navigate to “drivers\winMe,9x\usb.” Then
choose [OK].

9 Follow the instructions on the screen to complete the installation.

10 When the following dialog box displays, choose [Finish] to finish the in-
stallation.

This completes the installation of the USB device driver for the
PagePro 1250E printer.

11 When the Add New Hardware Wizard dialog box displays, continue
with step 2 of “To install the printer driver using Plug-and-Play under
Windows 98” on page 3-19.
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To install the USB device driver under Windows Me

1 Turn on your PC.

2 Turn on the printer.

3 When Windows and the printer are both ready, insert the CD-ROM
that came with your printer into your PC’s CD-ROM drive.

? What if the installation program starts up automatically?

➜ Close the dialog box by clicking the X in the upper-right corner.

4 Connect the printer to the PC with the USB cable (see chapter 2) to
display the Add New Hardware Wizard dialog box.

5 Check the “Specify the location of the driver (Advanced)” option but-
ton, and then choose [Next].

6 Check the “Search for the best driver for your device. (Recommend-
ed)”. option button, check the “Specify a location” box, and then
choose [Browse].

7 Browse the CD-ROM and navigate to “drivers\winMe,9x\usb.” Then
choose [OK].
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8 Follow the instructions on the screen to complete the installation.

9 When the following dialog box displays, choose [Finish] to finish the in-
stallation.

This completes the installation of the USB device driver for the
PagePro 1250E printer.

10 When the Add New Hardware Wizard dialog box displays, continue
with step 2 of “To install the printer driver using Plug-and-Play under
Windows Me” on page 3-20.
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To install the USB device driver under Windows 2000

If the printer is connected to the PC using a USB cable, USB Printing Sup-
port may automatically be incorporated, depending on the operating sys-
tem. In order to activate all functions of the PagePro 1250E, the USB
device driver for PagePro 1250E must be installed.

Install the USB device driver for PagePro 1250E according to the following
procedure.

1 Turn on your PC.

2 Turn on the printer.

3 When Windows and the printer are both ready, insert the CD-ROM
that came with your printer into your PC’s CD-ROM drive.

? What if the installation program starts up automatically?

➜ Close the dialog box by clicking the X in the upper-right corner.

4 Connect the printer to the PC with the USB cable (see chapter 2) to
display the Found New Hardware Wizard dialog box.
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5 Choose [Cancel] to close the “Found New Hardware Wizard” dialog
box.

6 Right-click the “My Computer” icon on the desktop, and then choose
“Properties” in the shortcut menu that displays. The System Properties
dialog box displays.

7 Choose the “Hardware” tab of the System Properties dialog box, and
then choose the [Device Manager] button.

8 Double-click “USB Printing Support” below “Universal Serial Bus con-
trollers.” The USB Printing Support Properties dialog box displays.

9 Choose the “Driver” tab of the USB Printing Support Properties dialog
box, and then choose [Update Driver].
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10 Choose [Next] to display the next dialog box.

11 Check the “Search for a suitable driver for my device (recommended)”
option button, and then choose [Next].

12 When the next dialog box displays, check the “Specify a location” box,
and then choose [Next].

13 Choose [Browse].

14 Browse the CD-ROM and navigate to “drivers\winMe,9x\usb.” Then
choose [Open].

15 Choose [OK], and then choose [Next].

16 Follow the instructions on the screen to complete the installation.
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17 When the following dialog box displays, choose [Finish] to finish in-
stalling the USB device driver.

18 Choose [Yes] to restart your PC.

19 When the following dialog box displays after restarting your PC, con-
tinue with step 4 of “To install the printer driver using Plug-and-Play”
on page 3-26.
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To install the USB device driver under Windows XP

If the printer is connected to the PC using a USB cable, USB Printing Sup-
port may automatically be incorporated, depending on the operating sys-
tem. In order to activate all functions of the PagePro 1250E, the USB
device driver for PagePro 1250E must be installed.

Install the USB device driver for PagePro 1250E according to the following
procedure.

1 Turn on your PC.

2 Turn on the printer.

3 When Windows and the printer are both ready, insert the CD-ROM
that came with your printer into your PC’s CD-ROM drive.

? What if the installation program starts up automatically?

➜ Close the dialog box by clicking the X in the upper-right corner.

4 Connect the printer to the PC with the USB cable (see chapter 2) to
display the Found New Hardware Wizard dialog box.
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5 Choose [Cancel] to close the “Found New Hardware Wizard” dialog
box.

6 Choose [Start], and then choose “My Computer.”

7 Choose “View system information” in the System Tasks list.

8 Choose the “Hardware” tab of the System Properties dialog box, and
then choose the [Device Manager] button.

9 Double-click “USB Printing Support” below “Universal Serial Bus con-
trollers.” The USB Printing Support Properties dialog box displays.
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10 Choose the “Driver” tab of the USB Printing Support Properties dialog

box, and then choose [Update Driver...].

11 Choose the “Install from a list or specific location (Advanced)” option
button, and then choose [Next].
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12 When the next dialog appears, check the “Don’t search. I will choose
the driver to install” box, and then choose [Next].

13 Choose [Have Disk...].

14 Choose [Browse...].

15 Browse the CD-ROM and navigate to “drivers\winMe,9x\usb.” Then
choose [Open].

16 Choose [OK], and then choose [Next].

17 Follow the instructions on the screen to complete the installation.

18 When the following dialog box displays, choose [Finish] to finish in-
stalling the USB device driver.

This completes the installation of the USB device driver for the
PagePro 1250E printer.

19 When the Found New Hardware Wizard dialog box displays, continue
with “Installing the printer driver under Windows XP” on page 3-31.
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3.4 Installing the printer driver using the installer (Auto
Run) under Windows
The CD-ROM supplied with the printer starts automatically after being
loaded into the CD-ROM drive of your PC. You are guided step-by-step
through the installation procedure.

1 Turn on the PC.

2 After Windows starts, insert the CD-ROM in the CD-ROM drive of your
PC.

The installation program starts automatically.

? What if the installation program does not start up automatically?

➜ In Windows Explorer browse to the CD-ROM directory. Then
double-click “setup.exe” to start the installation program.

3 Follow the instructions for the installation program.

❍ If a dialog box allowing you to select whether to install printer tools
displays, check the “Printer tools” box if you want to install the Sta-
tus Monitor and the Printer Control Panel. Then choose [OK] to dis-
play the next step.

❍ Once the printer driver has been successfully installed, the
“MINOLTA-QMS PagePro 1250E” printer icon displays in the
Printers dialog box.

❍ If Printer tools was installed, restart the PC.
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3.5 Installing the printer driver under Windows 95
For a simple way of installing the printer driver, we recommend using the
Auto Run installer. (See “Installing the printer driver using the installer (Au-
to Run) under Windows” on page 3-15.)

However, there are other ways of installing the printer driver without using
the installer. This section provides information on installing the PagePro
1250E printer driver under Windows 95.

✎
Installing the PostScript printer driver
The PostScript printer driver can be installed under Windows only by
using the Add Printer Wizard.

To install the printer driver using Plug-and-Play

1 After connecting the printer to your PC with the parallel cable, turn on
the printer.

2 Turn on the PC.
After Windows starts, the Update Device Driver Wizard dialog box dis-
plays.

3 Insert the CD-ROM that came with your printer into your PC’s CD-
ROM drive, and then choose [Next].

4 Choose [Other Locations], and then choose [Browse].

5 Browse the CD-ROM and navigate to “drivers\winMe,9x\pclx\english.”
Then choose [OK].
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6 Follow the instructions on the screen to complete the installation.

7 Check that the “MINOLTA-QMS PagePro 1250E” printer icon is dis-
played in the Printers dialog box. To display the Printers dialog box,
choose [Start], point to [Settings], and then choose [Printers].

8 Remove the CD-ROM from your PC’s CD-ROM drive. This completes
the installation of the printer driver.

To install the printer driver using the Add Printer Wizard

1 Turn on the PC.

2 After Windows starts, insert the CD-ROM that came with your printer
into your PC’s CD-ROM drive.

3 Choose [Start], point to [Settings], and then choose [Printers].

4 Double-click the “Add Printer” icon.
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5 Choose [Next].

6 Select “Local Printer.”

7 Choose [Next].

8 Choose [Have Disk], and then choose [Browse].

9 Browse the CD-ROM and navigate to “drivers\winMe,9x\pclx\english”
(for the PCL printer driver) or “drivers\winMe,9x\ps\english” (for the
PostScript printer driver). Then choose [OK].

10 Choose [OK], and then choose [Next].

11 Follow the instructions on the screen to complete the installation.

12 Check that the “MINOLTA-QMS PagePro 1250E” printer icon is
displayed in the Printers dialog box.

13 Remove the CD-ROM from your PC’s CD-ROM drive. This completes
the installation of the printer driver.
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3.6 Installing the printer driver under Windows 98/Me
For a simple way of installing the printer driver, we recommend using the
Auto Run installer. (See “Installing the printer driver using the installer (Au-
to Run) under Windows” on page 3-15.)

However, there are other ways of installing the printer driver without using
the installer. This section provides information on installing the PagePro
1250E printer driver under Windows 98 or Windows Me.

✎
Installing the PostScript printer driver
The PostScript printer driver can only be installed under Windows by
using the Add Printer Wizard.

To install the printer driver using Plug-and-Play under Windows 98

The Plug-and-Play installation with a parallel connection is described be-
low. For details on the installation with a USB connection, see “To install
the USB device driver under Windows 98” on page 3-3.

1 After connecting the printer to your PC with the parallel cable, turn on
the printer.

2 Turn on the PC.
After Windows starts, the Add New Hardware Wizard dialog box dis-
plays.

3 Insert the CD-ROM that came with your printer into your PC’s CD-
ROM drive, and then choose [Next].
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4 Choose the “Display a list of all the drivers in a specific” button, and
then choose [Next].

5 Check “Printer,” and then choose [Next].

6 Choose [Have Disk], and then choose [Browse].

7 Browse the CD-ROM and navigate to “drivers\winMe,9x\pclx\english.”
Then choose [OK].

8 Choose [OK], and then choose [Next].

9 Follow the instructions on the screen to complete the installation.

10 Check that the “MINOLTA-QMS PagePro 1250E” printer icon is dis-
played in the Printers dialog box. To display the Printers dialog box,
choose [Start], point to [Settings], and then choose [Printers].

11 Remove the CD-ROM from your PC’s CD-ROM drive. This completes
the installation of the printer driver.

To install the printer driver using Plug-and-Play under Windows Me

The Plug-and-Play installation with a parallel connection is described be-
low. For details on the installation with a USB connection, see “To install
the USB device driver under Windows Me” on page 3-5.

1 After connecting the printer to your PC with the parallel cable, turn on
the printer.
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2 Turn on the PC.

After Windows starts, the Add New Hardware Wizard dialog box dis-
plays.

3 Insert the CD-ROM that came with your printer into your PC’s CD-
ROM drive, and choose the “Specify the location of the driver (Ad-
vanced)” button. Then choose [Next].

4 Check the “Display a list of all the drivers in a specific location, so you
can select the driver you want” option button, and then choose [Next].

5 Check “Printer,” and then choose [Next].

6 Choose [Have Disk], and then choose [Browse].

7 Browse the CD-ROM and navigate to “drivers\winMe,9x\pclx\english.”
Then choose [OK].

8 Choose [OK], and then choose [Next].

9 Follow the instructions on the screen to complete the installation.
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10 Check that the “MINOLTA-QMS PagePro 1250E” printer icon is dis-
played in the Printers dialog box. To display the Printers dialog box,
choose [Start], point to [Settings], and then choose [Printers].

11 Remove the CD-ROM from your PC’s CD-ROM drive. This completes
the installation of the printer driver.

To install the printer driver using the Add Printer Wizard under
Windows Me/98

1 Turn on the PC.

2 After Windows starts, insert the CD-ROM that came with your printer
into your PC’s CD-ROM drive.

3 Choose [Start], point to [Settings], and then choose [Printers].

4 Double-click the “Add Printer” icon.
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5 Choose [Next].

6 Select “Local Printer.”

7 Choose [Next].

8 Choose [Have Disk], and then choose [Browse].

9 Browse the CD-ROM and navigate to “drivers\winMe,9x\pclx\english”
(for the PCL printer driver) or “drivers\winMe,9x\ps\english” (for the
PostScript printer driver). Then choose [OK].

10 Choose [OK], and then choose [Next].

11 Specify the appropriate port.
If you are using a parallel connection, select “LPTx:” (x=1, 2, etc.).
If you are using a USB connection, select “USB001.”
Then choose [OK].

12 Follow the instructions on the screen to complete the installation.

13 Check that the “MINOLTA-QMS PagePro 1250E” printer icon is dis-
played in the Printers dialog box.

14 Remove the CD-ROM from your PC’s CD-ROM drive. This completes
the installation of the printer driver.
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3.7 Installing the printer driver under Windows NT 4.0
For a simple way of installing the printer driver, we recommend using the
Auto Run installer. (See “Installing the printer driver using the installer (Au-
to Run) under Windows” on page 3-15.)

However, there are other ways of installing the printer driver without using
the installer. This section provides information on installing the PagePro
1250E printer driver under Windows NT 4.0.

To install the printer driver using the Add Printer Wizard

1 Turn on the PC.

2 After Windows starts, insert the CD-ROM that came with your printer
into your PC’s CD-ROM drive.

3 Choose [Start], point to [Settings], and then choose [Printers].

4 Double-click the “Add Printer” icon.

5 Select “My Computer.”

6 Choose [Next].

7 Specify the ports you want to use and the choose [Next].

8 Choose [Have Disk], and then choose [Browse].

9 Browse the CD-ROM and navigate to “drivers\winnt\pclx\english” (for
the PCL printer driver) or “drivers\winnt\ps\english” (for the PostScript
printer driver). Then choose [Open].
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10 Choose [OK], and then choose [Next].

11 Follow the instructions on the screen to complete the installation.

12 Check that the “MINOLTA-QMS PagePro 1250E” printer icon is dis-
played in the Printers dialog box.

13 Remove the CD-ROM from your PC’s CD-ROM drive. This completes
the installation of the printer driver.
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3.8 Installing the printer driver under Windows 2000
For a simple way of installing the printer driver, we recommend using the
Auto Run installer. (See “Installing the printer driver using the installer (Au-
to Run) under Windows” on page 3-15.)

However, there are other ways of installing the printer driver without using
the installer. This section provides information on installing the PagePro
1250E printer driver under Windows 2000.

✎
Installing the PostScript printer driver
The PostScript printer driver can be installed under Windows only by
using the Add Printer Wizard.

To install the printer driver using Plug-and-Play

For a parallel connection:

1 After connecting the printer to your PC, turn on the printer.

2 Turn on the PC.
After Windows starts, the Found New Hardware Wizard dialog box
displays.

❍ Continue with step 5 on the following page.
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For a USB connection:

1 Turn on your PC.

2 Turn on the printer.

3 When Windows and the printer are both ready, connect the printer to
the PC with the USB cable (for details, refer to chapter 2) to display the
Found New Hardware Wizard dialog box.

4 Insert the CD-ROM that came with your printer into your PC’s CD-
ROM drive, and then choose [Next].

5 Check the “Display a list of the known drivers for this device so that I
can choose a specific driver” option button, and then choose [Next].

6 Choose “Printers,” and then choose [Next].

7 Choose [Have Disk], and then choose [Browse].

8 Browse the CD-ROM and navigate to “drivers\win2k\pclx\english.”
Then choose [Open].

9 Choose [OK], and then choose [Next].

10 Follow the instructions on the screen to complete the installation.
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11 Check that the “MINOLTA-QMS PagePro 1250E” printer icon is dis-
played in the Printers dialog box. To display the Printers dialog box,
choose [Start], point to [Settings], and then choose [Printers].

12 Remove the CD-ROM from your PC’s CD-ROM drive. This completes
the installation of the printer driver.

✎
Note
With a USB connection, the USB device driver for the PagePro 1250E
must be installed. Leave the CD-ROM in the CD-ROM drive and install
the USB device driver. See “To install the USB device driver under
Windows 2000” on page 3-7.
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To install the printer driver using the Add Printer Wizard

1 Turn on the PC.

2 After Windows starts, insert the CD-ROM that came with your printer
into your PC’s CD-ROM drive.

3 Choose [Start], point to [Settings], and then choose [Printers].

4 Double-click the “Add Printer” icon.

5 Choose [Next].

6 Select “Local printer.”

❍ Do not check the “Automatically detect and install my Plug and
Play printer” box.

7 Choose [Next].

8 Choose the “Use the following port:” button, and specify the ports you
want to use and then choose [Next].
If you are using a parallel connection, select “LPTx:” (x=1, 2, etc.).
If you are using a USB connection, select “USB001.”

9 Choose [Have Disk], and then choose [Browse].

10 Browse the CD-ROM and navigate to “drivers\win2k\pclx\english” (for
the PCL printer driver) or “drivers\win2k\ps\english” (for the PostScript
printer driver). Then choose [Open].

11 Choose [OK], and then choose [Next].
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12 Follow the instructions on the screen to complete the installation.

13 Check that the “MINOLTA-QMS PagePro 1250E” printer icon is dis-
played in the Printers dialog box.

14 Remove the CD-ROM from your PC’s CD-ROM drive. This completes
the installation of the printer driver.
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3.9 Installing the printer driver under Windows XP
For a simple way of installing the printer driver, we recommend using the
Auto Run installer. See “Installing the printer driver using the installer
(Auto Run) under Windows” on page 3-15.

However, there are other ways of installing the printer driver without using
the installer. This section provides information on installing the PagePro
1250E printer driver under Windows XP.

✎
Installing the PostScript printer driver

The PostScript printer driver can be installed under Windows only by us-
ing the Add Printer Wizard.

To install the printer driver using Plug-and-Play

For a parallel connection:

1 After connecting the printer to your PC, turn on the printer.

2 Turn on the PC.
After Windows starts, the Found New Hardware Wizard dialog box
displays.

❍ Continue with step 5 on the following page.
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For a USB connection:

1 Turn on your PC

2 Turn on the printer.

3 When Windows and the printer are both ready, connect the printer to
the PC with the USB cable (for details, refer to chapter 2) to display the
Found New Hardware Wizard dialog box.

4 Insert the CD-ROM that came with your printer into your PC’s CD-
ROM drive, and then choose [Next].

5 Check the “Install from a list or specific location (Advanced)” option
button, and then choose [Next].

6 Check the “Don’t search, I will choose the driver to install” option
button, and then choose [Next].

7 Select “Printers” in the Common hardware types list, and then choose
[Next].

8 Choose [Have Disk], and then choose [Browse].

9 Browse the CD-ROM and navigate to “drivers\win2k\pclx\english.”
Then choose [Open].

10 Choose [OK], and then choose [Next].
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11 Follow the instructions on the screen to complete the installation.

✎
Note
With a USB connection, the USB device driver for the MINOLTA-QMS
PagePro 1250E must be installed. Leave the CD-ROM in the CD-
ROM drive and install the USB device driver. See “To install the USB
device driver under Windows XP” on page 3-11.

To install the printer driver using the Add Printer Wizard

1 Turn on the PC.

2 After Windows starts, insert the CD-ROM that came with your printer
into your PC’s CD-ROM drive.

3 Choose [Start], and then Choose “Control Panel.”
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4 In “Pick a category” choose “Printers and Other Hardware.”

5 In “Pick a task” choose [Add a printer].

6 Choose [Next].

7 Select “Local printer attached to this computer.”

❍ Do not check the “Automatically detect and install my Plug and
Play printer” box.
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8 Choose [Next].

9 Choose the “Use the following port:” button, and specify the ports you
want to use and then choose [Next].
If you are using a parallel connection, select “LPTx:” (x=1, 2, etc.).
If you are using a USB connection, select “USB001.”

10 Choose [Have Disk], and then choose [Browse].

11 Browse the CD-ROM and navigate to “drivers\win2k\pclx\english” (for
the PCL printer driver) or “drivers\win2k\ps\english,” and then choose
[Open].

12 Choose [OK], and then choose [Next].

13 Follow the instructions on the screen to complete the installation.

14 Remove the CD-ROM from your PC’s CD-ROM drive. This completes
the installation of the printer driver.
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3.10 Installing the PostScript printer driver under Mac OS

✎
Note
If Mac OS X or later is being used, switch to the Classic environment
before performing the following procedure.

To install the PostScript printer driver under Mac OS

Use the following procedure to install the PostScript printer driver under
Mac OS.

1 After connecting the printer to your Macintosh with the USB cable, turn
on the printer.

2 Turn on the Macintosh.

3 When the Macintosh is ready, insert the CD-ROM that came with your
printer into your computer’s CD-ROM drive.

4 Double-click on “MINOLTA-QMS” icon to start the installation pro-
gram.

5 Double-click the “install” icon.

6 Follow the instructions on the screen to complete the installation.

7 After the printer driver is installed, continue with the following section
to specify the USB printer settings.
3-36 EDNord - Istedgade 37A - 9000 Aalborg - telefon 96333500



Installing a printer driver 3

To specify the USB printer settings

Use the following procedure to specify the USB printer settings in order to
print through the USB port.

Note

✔ To use this USB software for printing with PagePro 1250E, Apple
LaserWriter 8.3 or later must be installed. First, check the version of
LaserWriter installed on the Macintosh.

1 Open the Macintosh Hard Disk icon on the desktop.

2 Open the “Apple Extras” folder.

If your Macintosh is running Mac OS 9.1 or later, open the Applications
folder.

3 Open the “Apple LaserWriter Software” folder.

If your Macintosh is running Mac OS 9.1 or later, open Utilities folder.

4 Double-click “Desktop Printer Utility.”

5 Choose “Printer (USB)” from the “Create Desktop” list, and then
choose [OK].

6 Choose [Change] from the “PostScript Printer description (PPD) file”
section to select a specific driver.

7 Choose “MINOLTA-QMS PagePro 1250E,” and then choose [Select].

8 Choose [Change] from the “USB Printer Selection” section to select
the USB printer.

9 Choose “PagePro 1250E,” and then choose [OK].

10 Choose [Create].

11 Select the location and name for your printer, and then choose [Save].

This completes the installation of the printer driver and the specifica-
tion of the USB printer settings.
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3.11 Uninstalling the PCL printer driver and USB device
driver
This section describes how to uninstall the PagePro 1250E printer driver
when necessary.

✎
Note
If the uninstallation program is used to remove the printer driver, the
USB device driver is also removed.

✎
Note
If you used Add Printer to install the printer driver, there is no
uninstaller utility. To remove the printer, select it and delete it in the
Printers folder.

✎
Note
The screen images that appear in this section show the examples of
uninstallation under Windows 98. Your screen may differ slightly.

To uninstall the PCL printer driver under Windows Me/98/95/2000/
NT 4.0

1 Choose the [Start] button, point to [Settings], and then choose [Control
Panel].
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2 Double-click the “Add/Remove Programs” icon in the Control Panel

dialog box to open the Add/Remove Programs Properties dialog box.
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3 Installing a printer driver
3 For Windows Me/98/95/NT 4.0, select “MINOLTA-QMS PagePro
1250E Printer,” and then choose [Add/Remove] to uninstall the printer
driver.

For Windows 2000, select “MINOLTA-QMS PagePro 1250E Printer,”
and then choose [Change/Remove] to uninstall the printer driver.
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4 Choose [Uninstall] to proceed with the uninstallation or [Cancel] to

abort.

5 After the PagePro 1250E printer driver has been removed, choose
[OK].

6 Choose [Yes] to close the window.

✎
Note
It is recommended that you restart your computer after uninstallation.
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To uninstall the printer driver under Windows XP

1 Choose the [Start] button, and then choose“Control Panel.”

2 In “Pick a category” choose “Add or remove Programs” to open the
Add or Remove Programs dialog box.

3 Select “MINOLTA-QMS PagePro 12050E,” and then choose [Change/
Remove] to uninstall the printer driver.
3-42 EDNord - Istedgade 37A - 9000 Aalborg - telefon 96333500



Installing a printer driver 3

4 Select “MINOLTA-QMS PagePro 1250E” in the Uninstall dialog box.

5 Choose [Uninstall] to proceed with the uninstallation or [Cancel] to
abort.

6 When the following dialog box displays, choose [Yes] to restart the PC.

✎
Note
If is recommended that you restart your computer after uninstallation.
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4 Working with the Windows PCL
printer drivers

4.1 Displaying printer driver settings (Windows Me/98/
95/2000/NT 4.0)

1 From the Start menu, choose Settings and then Printers to display the
Printers directory.

2 Select the MINOLTA-QMS PagePro 1250E printer icon.

3 Display the printer driver settings:

� Windows Me/98/95—From the File menu choose Properties. The
following window displays.

✎
The operating system also uses tabs!
The “General” and “Details” tabs are automatically determined by the
operating system and are therefore not described in this manual.
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4 Working with the Windows PCL printer drivers
� Windows 2000—From the File menu choose Printing Preferenc-
es. The following window displays.

� Windows NT 4.0—From the File menu choose Document De-
faults. A window similar to the Windows 2000 window shown
above displays.

4.2 Displaying printer driver settings (Windows XP)

1 From the Start menu, choose Control Panel.

2 In Pick a Category choose Printers and Other Hardware.

3 In Pick a task choose View installed printers or fax printers.

4 Select the MINOLTA-QMS PagePro 1250E printer icon.

5 To display the printer driver settings, from the File menu choose
Printing Preferences...
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4.3 Paper tab

The Paper tab allows you to

� Select a media size

� Define custom media sizes

� Fit printed documents to a specified media size

� Specify the orientation of the media

� Specify paper feed from different trays

� Define the type of paper/media

� Scale (enlarge/reduce) documents

� Specify the number of copies

� Turn on/off the printer’s sorting function

� Turn on/off the Proof Print function

Refer to the printer driver’s online help for information on all of these func-
tions.
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4.4 Page Layout tab

The Page Layout tab allows you to

� Specify manual duplex printing (you cannot duplex from the manual
feed tray)

� Print several pages of a document on the same page (n-up printing)

� Provide a watermark on printed documents

� Design custom watermarks

� Adjust the printable area

Refer to the printer driver’s online help for information on all of these func-
tions.
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4.5 Quality tab

The Quality tab allows you to

� Turn on/off Toner Save mode

� Optimize the print quality of text and graphics (Fine-Art)

� Specify the toner density

� Optimize the exchange of text and graphics data with the printer
(All Raster)

� Specify the resolution

� Activate/deactivate the use of TrueType Fonts

� Turn on/off the photo enhancement function

Refer to the printer driver’s online help for information on all of these func-
tions.
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4.6 Device Option tab

The Device Option tab allows you to

� Activate the optional lower feeder unit (Tray 2)

� Define the total amount of memory installed in the printer

Refer to the printer driver’s online help for information on all of these func-
tions.

Windows 2000/NT 4.0 only!
The Device Option tab for Windows 2000/NT 4.0 is integrated in a differ-
ent system sector and must be called up separately.

1 From the Start menu choose Settings and then Printers to display the
Printers dialog.

2 In the Printers dialog, select the MINOLTA-QMS PagePro 1250E
printer icon.

3 From the File men choose Properties to display the Properties dialog
box.

4 Choose the Device Option tab.
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5 Working with the Windows PostScript
printer drivers

5.1 Displaying printer driver settings (Windows Me/98/
95, 2000, NT 4.0)

1 From the Start menu choose Settings and then Printers to display the
Printers window.

2 In the Printers window, select the MINOLTA-QMS PagePro 1250E PS
printer icon.

3 Display the printer driver settings:

� Windows Me/98/95—From the File menu choose Properties. The
Properties window displays.
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� Windows 2000—From the File menu choose Printing Preferenc-
es... The Printing Preferences window displays.

� Windows NT 4.0—From the File menu choose Document De-
faults... The Default Document Properties window displays.

5.2 Displaying printer driver settings (Windows XP)

1 From the Start menu, choose Control Panel.

2 In Pick a Category choose Printers and Other Hardware.
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3 In Pick a task choose View installed printers or fax printers.

4 Select the MINOLTA-QMS PagePro 1250E printer icon.

5 To display the printer driver settings, from the File menu choose
Printing Preferences...

5.3 Paper tab (Windows Me/98/95)

The Paper tab allows you to

� Specify a media size (see appendix A for a list of supported media
sizes)

� Define custom media sizes

❍ minimum size: 3.0" × 5.0" 76 × 127 mm
❍ maximum size: 8.5" × 14.0" 216 × 356 mm

� Print several pages of a document on the .same page (n-up printing)

� Specify the orientation of the media

� Specify a media source

➜ To feed media manually, place a sheet of media in the manual feed
tray and then press the panel button.

� Specify the number of copies

Refer to the printer driver’s online help for information on all of these
functions.
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5.4 Device Options tab (Windows Me/98/95)

Available printer memory

This item allows you to specify the amount of memory (in KB) installed in
your printer.

Printer features

The items in this list box allow you to fine-tune the general features of the
printer for a specific document.

� Collate—Controls whether collation of multiple printed copies should
be performed by the printer (On) or by the application (Off)

� Fine-Art—Improves the appearance of text and graphics by smoothing
jagged edges by using fewer (Light) or more (Dark) dots

� Fit to Page—Scales the printed document to fit on the specified media
size

� ImageShift—Allows you to adjust the horizontal (X) and vertical (Y)
printable area on the physical page (use this item with X-Image Shift
and Y-Image Shift)

� Media Type—Identifies the type of media to be printed

� MultiBit—Controls multibit printing

� Print Watermark—Specifies whether the watermark should be printed
on all pages of the document or on just the first page
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� Proof Print—Stops printing after the first copy of a multi-copy print job

so that you can confirm print quality

� Toner Density—Adjusts the density of the toner used during printing

� Toner Save—Allows you to conserve toner when printing rough drafts
or sample documents

� Watermark—Specifies the text of the watermark to be printed

� Watermark Angle—Specifies the angle of the watermark on the page

� Watermark Font—Specifies the font used to print the watermark

� Watermark Size—Specifies the size (in points) of the watermark

� X-Image Shift—Specifies the amount (in points) to move the printable
area horizontally on the physical page

� Y-Image Shift—Specifies the amount (in points) to move the printable
area vertically on the physical page

To modify a feature, first select the item and then select one of the corre-
sponding settings in the Change Setting For list box.

Installable options

This list box displays the options that are available for installation on your
printer.

To change the setting for an option, first select the option and then select
one of the corresponding settings in the Change Setting For list box.

� VMOption—Allows you to specify the amount of memory installed in
your printer.
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5.5 Page Setup tab (Windows NT 4.0)

The Page Setup tab allows you to

� Specify a media size

� Specify a media source

➜ To feed media manually, place a sheet of media in the manual feed
tray and then press the panel button.

� Specify the number of copies

� Specify the orientation of the media

Refer to the printer driver’s online help for more information on the Page
Setup tab.
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5.6 Advanced tab (Windows NT 4.0)

The Advanced tab allows you to control and fine-tune many of the ad-
vanced features of your printer driver. The features are organized in a tree
format with three main branches:

� Paper/Output

� Graphic

� Document Options

To change the setting for a feature, first select the feature in the top win-
dow and then select one of the corresponding settings in the bottom win-
dow.

Refer to the printer driver’s online help for more information on the Ad-
vanced tab.
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5.7 Device Settings tab (Windows NT 4.0)

The Device Settings tab for Windows NT 4.0 is integrated in a different
system sector and must be called up separately.

1 From the Start menu, choose Settings, and then choose Printers to
display the Printers window.

2 In the Printers window, select the MINOLTA-QMS PagePro 1250E PS
printer icon.

3 From the File menu choose Properties. The Properties window dis-
plays.

4 Choose the Device Settings tab.

The Device Settings tab consists of two windows that allow you to specify
and manage the options that have been installed on your printer. The top
window displays the features and current settings. The bottom window al-
lows you to change the settings. The contents of the bottom window are
determined by the item that is selected in the top window.

To change the setting for a feature, first select the feature in the top win-
dow and then select one of the corresponding settings in the bottom win-
dow.

Refer to the printer driver’s online help for more information on the Device
Settings tab.
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5.8 Layout tab (Windows 2000)

The Layout tab allows you to

� Specify the orientation of the media

� Specify the order in which the pages of the document should be print-
ed

� Print several pages of a document on the same sheet of media
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5.9 Paper/Quality tab (Windows 2000)

The Paper/Quality tab allows you to

� Specify a media source

➜ To feed media manually, place a sheet of media in the manual feed
tray and then press the panel button.
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Advanced Options (Windows 2000)

Choose the Advanced... button on either the Layout tab or the Paper/
Quality tab to open the Advanced Options window.

The settings in this window allow you to control and fine-tune many of the
advanced features of your printer driver. The features are organized in a
tree format with three main branches: Paper/Output, Graphic and Docu-
ment Options.

Refer to the printer driver’s online help for more information on the Ad-
vanced Document Settings.
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5.10 Device Settings tab (Windows 2000)

The Device Settings tab for Windows 2000 is integrated in a different sys-
tem sector and must be called up separately.

1 From the Start menu, choose Settings, and then choose Printers to
display the Printers window.

2 In the Printers window, select the MINOLTA-QMS PagePro 1250E PS
printer icon.

3 From the File menu choose Properties. The Properties window dis-
plays.

4 Select the Device Settings tab.

The Device Settings dialog box appears.

The Device Settings tab allows you to view and change the setup of the
printer and its options. To change a setting, select the item that you want
to change, and then select the desired setting from either the box or drop-
down list that appears.

Refer to the printer driver’s online help for more information on the Device
Settings tab.
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6 Working with the Windows printer
tools

The Windows printer tools include the following:

� Status Monitor

� Printer Control Panel

✎
Automatic startup of Status Monitor!
If ,when you installed the printer driver, you activated the option to au-
tomatically start the printer driver, then the Status Monitor also auto-
matically starts when you start the computer.

6.1 Environment
The Status Monitor and Printer Control Panel can be used with the follow-
ing operating systems and interfaces.

IEEE 1284 Parallel USB

Windows XP 2 2

Windows Me 2 2

Windows 2000 2 2

Windows 98 2 2

Windows 98 SE 2 2

Windows 95 2 —

Windows NT 4.0 2 —
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6.2 Opening the Status Monitor
The Status Monitor allows you to monitor the printer and the progress of
current print jobs. Use one of the following steps to open the Status
Monitor.

➜ Windows Me/98/95/2000/NT 4.0—From the Start menu, choose Pro-
grams, then MINOLTA-QMS PagePro 1250E, and then MINOLTA-
QMS PagePro 1250E Printer Tools to display the Status Monitor.

➜ Windows XP—Choose Start, choose All Programs, then MINOLTA-
QMS PagePro 1250E, and then MINOLTA-QMS PagePro 1250E
Printer Tools to display the Status Monitor.

Altering the size of the Status Monitor window

➜ From the View menu choose Expand to increase the size of the
window.

➜ From the View menu choose Reduce to decrease the size of the
window.
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6.3 Monitoring print jobs with the Status Monitor
� When the background of the printer graphic is green, the printer is in

Stand-by mode or a job is printing normally.

� When the background to the printer graphic is red, there is an error
and the job has been interrupted. The status of the printer and the
error message are shown in the dialog boxes on the left.
6-3EDNord - Istedgade 37A - 9000 Aalborg - telefon 96333500



6 Working with the Windows printer tools
6.4 Opening the Printer Control Panel
The Printer Control Panel lets you check and/or alter the basic settings of
the printer. Use the following steps to open the Control Panel:

1 From the Start choose Programs, then MINOLTA-QMS PagePro
1250E, and then MINOLTA-QMS PagePro 1250E Printer Tools to dis-
play the Status Monitor.

2 Choose the Printer Setting... button
or
from the Setup menu choose Printer Setting to display the Control
Panel.
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6.5 Paper tab

The Paper tab allows you to

� Specify how the printer should respond to a media size error (the re-
quested media size is not available)

� Specify whether Tray 1 is to be used as a multipurpose (universal) tray
or as a tray set to a single media size

Refer to the Printer Control Panel’s online help for information on all of
these functions.

✎
Turn on “Auto continue”!
The Auto Continue option on the Printer Setting tab allows you to
specify whether a print job is to continue after a certain amount of time
has elapsed despite a paper size error.

✎
Settings
The settings for Tray 1 on the Paper tab may be overridden by the set-
tings in other printing applications!
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6.6 Printer Setting tab

The Printer Setting tab allows you to

� Turn on/off the Power Save mode

� Turn on/off the automatic continuation in case of a format or memory
overflow error

� Switch between fast and normal printing modes

� Turn on/off printing of a PostScript error report

� Define the length of time the printer waits for the end of a print job be-
fore timing out

� Turn on/off detection of media size errors

� Activate the page protection function (the printer waits until the data for
a page has been completely loaded into memory before printing)

� Define the printer personality (PostScript, PCL, or auto-switching)

Refer to the Printer Control Panel’s online help for information on all of
these functions.
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6.7 Test Print tab

The Test Print tab allows you to

� Print a demonstration page, an overview of all printer functions

� Print a configuration page, listing current printer settings

� Print a list of PCL-resident fonts with designations and samples

� Print a list of PostScript-resident fonts with designations and samples

� Print an overview of the most important LED indicator light patterns
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6.8 Counter tab

The Counter tab allows you to

� Check the status of a counter

� Reset a counter (when starting a new media count in one of the trays
or after replacing a consumable)

➜ Click [Reset] adjacent the counter you want to reset.

The associated counter is reset to zero.
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6.9 Configuration tab

The Configuration tab summarizes the most important printer settings for
quick reference.

No settings can be altered on this tab.
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7 Working with the Macintosh printer
driver

7.1 Page Attributes settings
The Page Setup dialog contains settings that affect the format and output
of your printed documents.

Paper

The Paper setting allows you to specify a media size. See the list of sup-
ported media sizes in chapter 12, "Specifications."

Orientation

The Orientation setting allows you to specify how your document is posi-
tioned on the printed page.

Scale

You can adjust the area of a document through the Scale setting. The
maximum percentage of enlargement is 400. The maximum percentage
of reduction is 25.
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Custom Page

1 Enter the dimensions for the custom width and height into the appro-
priate boxes.

� minimum size: 3.0" × 5.0" 76 × 127 mm

� maximum size: 8.5" × 14.0" 216 × 356 mm

2 Specify either inches or centimeters, and then choose OK.

7.2 General settings
This section describes specific settings that you can make with this printer
driver.
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Copies

Specify the number of copies to be printed. You can specify any value
from 1 to 999.

Collated

When you are printing more than one copy of a document, you can enable
the Collated feature to sort documents as they are sent to the output tray
(pages 1,2,3... , 1,2,3..., 1,2,3).

Paper Source

Select “All pages from” to print all pages of the document onto paper from
the same tray.

Select “First page from” to print only the first page of a document onto pa-
per from a specified tray.

To print the remaining pages of the document from a tray other than the
“First page from:” tray, specify the appropriate tray from the “Remaining
from:” options.

If the paper source is set to “Auto Select,” the printer automatically selects
the paper source according to the specified paper size.

7.3 Layout settings

Pages per sheet

This setting allows you to print more than one page of your document on
a single sheet of paper. From the drop-down list you can select 1, 2, 4, 6,
9, or 16.
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Layout direction

You can select how the multiple pages will be laid out on the single sheet
of paper: right to left or left to right.

Border

You can also select the type of border that is placed between the multiple
pages on the single sheet of paper.

7.4 Printer-Specific Options 1 settings

Fit to Page

The “Fit to Page” setting allows you to fit your document to a certain paper
size when it is printed. Your document will be automatically enlarged or
reduced so that it will fit on the paper size you have selected.

Watermark

Watermarks quickly alert the reader to the nature of a document’s content.
You can select a watermark (such as Confidential or Draft,) and also spec-
ify several options that affect its style, content, and placement.
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7.5 Printer Specific Options 2 settings

Toner Saving

Turning on this option uses less toner, but produces lighter printing.

Media Type

Use this drop-down list to specify the type of media you are printing on:
Plain Paper, Transparency, Thick paper, Envelope, or Postcard.

Fine Art

The “Fine Art” settings allow you to optimize the print quality of the text and
graphic images of a document.

Resolution

The “Resolution” setting determines the number of dots per inch used
when a document is printed. Documents printed in higher resolution are
sharper; however, they may take longer to print.

Tray 2

Set the "Tray2" setting to Installed if the optional lower feeder unit (Tray 2)
is installed.
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8 Working with the printer

8.1 Please note the following points

What should I watch out for when loading paper?

To avoid paper misfeeds, observe the following points:

� Do not use any paper with the following features:

❍ Paper that has already been used in a thermal or ink-jet printer.
❍ Creased or wavy paper.
❍ Paper with a surface that is too smooth, too rough, or irregular.
❍ Specially coated paper such as carbon paper or paper with an ad-

hesive surface.
❍ Paper that is not cut at right-angles.
❍ Paper that is held together by glue, adhesive, or clips.
❍ Paper with labels that detach easily.
❍ Warped or curled-up postcards.

� Do not allow the stack of paper in the paper tray to exceed the media
limit mark.

What should I watch out for when loading envelopes?

To avoid envelope misfeeds in the laser printer, observe the following
points:

� Do not use self-adhesive envelopes or those with a tear-off strip, clo-
sures, or a window.

� Place the envelopes in the tray with the flap down and facing to the left.

� Make sure that the flaps are neatly folded back.

✎
Test envelopes before buying large quantities!
Some types of envelopes crease easily when they are run through a
printer. Test a brand of envelope before purchasing large quantities.
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Which media sizes can I use?

This printer is designed for use only with these media sizes.

* The optional lower feeder unit (Tray 2) is shipped with either a letter or A4 tray. Legal and
executive/B5 JIS trays are available as optional accessories.

Media size
Media source

Tray 1 Tray 2* (optional) Manual feed tray

Standard sizes

Letter
8.5" x 11.0"

Yes Yes Yes

Legal
8.5" x 14.0"

Yes Yes Yes

Executive
7.25" x 10.5"

Yes Yes Yes

Half Letter
5.5" x 8.5"

Yes No Yes

A4
210 x 297 mm

Yes Yes Yes

A5
148 x 210 mm

Yes No Yes

B5 JIS
182 x 257 mm

Yes Yes Yes

Chinese 16K
185 x 260 mm

Yes No Yes

Chinese 32K
130 x 185 mm

Yes No Yes

Envelopes, postcards, and custom paper sizes

Envelope Monarch
3.875" x 7.5"

Yes No Yes

Envelope COM10
4.125" x 9.5"

Yes No Yes

Envelope DL
110 x 220 mm

Yes No Yes

Envelope C5
162 x 229 mm

Yes No Yes

Envelope C6
114 x 162 mm

Yes No Yes

Envelope B5
176 x 250 mm

Yes No Yes

Choukei-3Gou
120 x 235 mm

Yes No Yes

Choukei-4Gou
90 x 205 mm

Yes No Yes

Postcard
100 x 148 mm

Yes No Yes

Custom
3.0"– 8.5" x 5.0"–14.0"
(76–216 mm x 127–
356 mm)

Yes No Yes
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What types of media can I use?

This printer is designed for use with the following media types.

Printable area

Media type
Media source

Tray 1 Tray 2 (optional) Manual feed tray

Plain paper
16–24 lbs (60–90 g/m2)

Yes Yes Yes

Thick paper
24–43.25 lbs (90–163 g/m2)

Yes No Yes

Envelopes Yes No Yes

Letterhead Yes No Yes

Postcard Yes No Yes

Transparencies Yes No Yes

Printable area

0.2" (4 mm)

0.2" (4 mm)

0.2" (4 mm)0.2" (4 mm)
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8.2 Using the panel button

The control panel has two indicators and one button.

The panel button allows you to

� Print special pages (configuration page, PCL font list, PostScript font
list)

� Continue a print job after an error message

� Cancel a print job

� Reset the counter

Printing special pages

1 Make sure that

❍ The green “Ready” indicator is on (but not blinking)
❍ The orange “Error” indicator is off

2 Briefly press the panel button.

All indicators blink rapidly.

3 Press the panel button again:

1

2

3

No. Description No. Description

1 Error indicator (orange) 3 Panel button

2 Ready indicator (green)

Press the panel key this many more
times...

to print this special page

2 Configuration page

3 PCL font list

4 PostScript font list
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Continuing a print job after an error message

You can continue the print job after correcting the following types of errors:

✔ When the print job is too complex and the memory capacity of the
printer is inadequate

✔ When there is no more paper in the trays

✔ When paper of a different format than that set in the printer driver was
fed into the printer

1 Check that one of the above errors has occurred.

2 Press the panel button to operate the media feed.

The print job continues.

✎
Check your printed document!
If you have continued a print job after an error message, be sure to
check your printed document. Not all pages may have printed.

Cancelling a print job

You can cancel a print job that is currently being processed.

1 While data is being processed or printed (the green “Ready” indicator
is blinking), hold down the panel button for more than 5 seconds.

2 Release the panel button after both indicators light up.

The current print job has now been cancelled.
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8 Working with the printer
8.3 Loading media

Loading media in Tray 1

Note the following points:

✔ Refill the tray only when it is completely empty.

✔ Refer to the advice on loading media on page 8-1.

1 Remove the tray cover.

2 Squeeze the right media guide and
open the media guides.

3 Place the media in the tray.

? How many sheets of paper may
I place on the tray?

➜ Tray 1 has a capacity of 250
sheets of plain paper. The stack
of paper should not rise above
the media limit mark.

? How is letterhead fed in?

➜ Load letterhead with the side to
be printed facing up and the preprinted letterhead at the top (facing
the printer).

? What if I am loading legal-size paper?

➜ Open the cover at the front of the tray.

4 Squeeze the right media guide and adjust the media guides so that
both the left and right sides of the media are secure.

5 Replace the tray cover.
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Loading media in the manual feed tray

1 Make sure that the tray cover is properly attached to Tray 1.

2 Open the media guides.

3 Insert the piece of media as far as
possible into the manual feed tray
(with the side to be printed facing
up).

? How many pieces of media can
be fed at one time?

➜ Insert only one sheet of paper or
type of media at a time.

? How are envelopes fed in?

➜ Place the envelope in the tray with the side to be printed facing up.
The flap of the envelope should be facing down and to the left.

? How is letterhead fed in?

➜ Load letterhead with the side to be printed facing up and the pre-
printed letterhead at the top (facing the printer).

4 Adjust the media guides so that both sides of the media are secure.

Loading media in the lower feeder unit (Tray 2)

Note the following points:

✔ The optional lower feeder unit (Tray 2) is shipped with either a letter or
A4 tray. Legal and executive/B5 JIS trays are also available as option-
al accessories.

✔ Refill the tray only when it is completely empty.

✔ Paper must be loaded short edge first.

✔ Refer to the advice on loading media on page 8-1.
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8 Working with the printer
1 Remove the tray 2 from the lower
feed unit by pulling it out as far as it
will go, gently raising up the front,
and sliding it the rest of the way out.

2 Remove the cover from the tray.

3 Press down on the paper lifting
plate until it locks into place.

4 Place a stack of paper into the tray.

? How many sheets of paper may
I place on the tray?

➜ Tray 2 has a capacity of 500
sheets of plain paper. The stack
of paper should not rise above
the media limit mark.

? How is letterhead fed in?

➜ Load letterhead with the side to be printed facing up and the pre-
printed letterhead at the top (facing the printer).

5 Replace the tray cover and insert
the tray into the lower feeder unit.
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8.4 Determining the direction of printed sheets
Printed sheets can be output in two ways:

� Face down

� Face up

The printer is fitted with a tray for face-down output. A tray for face-up out-
put is available as an option. This tray is especially suitable for thick paper
and envelopes because the path through the printer is straighter.

The face-down output tray can hold up to 100 sheets while the optional
face-up output tray holds 20 sheets.

No. Description No. Description

1 Face-down output tray 4 Output switch location for face-up output

2 Face-up output tray 5 Output switch location for face-down output

3 Output switch

1
2

4

5

3

1 2
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8 Working with the printer
Note the following points:

✔ Do not change the output direction while a print job is in progress.

✔ Make sure that the output switch is in the correct position when the op-
tional face-up output tray is not installed.
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9 Installing printer options

The following options are available for your printer:

� Lower feeder unit (Tray 2, 500-sheet capacity)

� Legal and exective/B5 JIS trays for the lower feeder unit

� Face-up tray

� SDRAM DIMM (Dual In-line Memory Module)

9.1 Installing the lower feeder unit (Tray 2)
The lower feeder unit can hold up to 500 sheets of plain paper. It is sup-
plied with either a letter (US) or A4 (Europe) tray (Tray 2).

1 Remove the lower feeder unit from its carton, and then remove the
plastic bag and all shipping materials.

2 Turn the printer off, and then disconnect the power cord and interface
cable from the printer.

3 Place the printer onto the lower feeder unit.

❍ Make sure to align the holes on
the bottom of the printer with the
coupling pins on the lower feed-
er unit.

4 Fill the tray with paper. (For details see chapter 8.)

? How many sheets of paper may I place on the tray?

➜ Tray 2 has a capacity of 500 sheets of plain paper. The stack of
paper should not rise above the media limit mark.
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9 Installing printer options
5 Replace the tray cover.

6 Insert the tray into the lower feeder
unit.

❍ Be sure to use both hands
whenever you are inserting the
tray into or removing it from the
lower feeder unit.

7 Reconnect the power cord and interface cable, and turn on the printer.
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9.2 Installing the face-up tray
The printer is fitted with a tray for face-down output. A tray for face-up out-
put is available as an option. This tray is especially suitable for thick paper
and envelopes because the path through the printer is straighter. The
face-up output tray holds 20 sheets.

1 Remove the face-up output tray from its carton.

2 Attach the face-up output tray by in-
serting the pins into the holes on the
printer, one side at a time. Do not
force both sides in at the same time.

❍ The face-up tray must be bent
slightly to insert it.

✎
Face-up or face-down output?
You can set the output direction with
the output switch. (For details see
chapter 8.)

No. Description

1 Output switch location for face-up
output

2 Output switch location for face-down
output

1

2
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9 Installing printer options
9.3 Installing a DIMM (Dual In-Line Memory Module)
This printer is shipped with 16 MB of memory. However, printer memory
can be expanded to a maximum of 144 MB by installing commercially
available PC/100-compatible SDRAM DIMMs (64 MB or 128 MB).

CAUTION

Your DIMM could be destroyed!

➜ DIMMs are very sensitive. Handling them improperly can damage
them and render them unusable.

➜ Before you unpack a DIMM, touch a metal part of the printer to dis-
charge the static electricity from you.

➜ Hold the DIMM only by the edges.

➜ Avoid touching the DIMM connections.

➜ Always place the DIMM on an anti-static mat when working with it.

➜ Do not touch any printed circuit boards in the printer.

WARNING

Risk of electric shock!
The printer contains electrical parts.

➜ Always turn the printer off and unplug it before installing a DIMM.

➜ When installing a DIMM, follow the instructions exactly.

➜ Remove only the printer covers which are specifically referred to in the
step-by-step instructions.

1 Turn the printer off and disconnect the power cord and the interface
cable from the printer.

2 Close the face-down output tray.
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3 Press the top cover release button

and open the top cover.

4 Facing the right side of the printer,
use a Phillips screwdriver to remove
the two screws holding the side cov-
er in place.

5 Remove the side cover by pulling it
toward you.

6 Insert the DIMM in the slot.

❍ Press the DIMM carefully into
the socket until it snaps into
place.

✎
Would you like to remove a
DIMM?
To remove a DIMM, press the tabs
on both sides of the installation slot
outwards. This releases the DIMM
and allows you to remove it.
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9 Installing printer options
7 Replace the side cover and secure
it with the two screws.

8 Close the top cover.

9 Open the face-down output tray.
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10 Enter the printer’s new total memory capacity in the printer driver (see
the printer driver’s online help).

11 Print a configuration page (see chapter 8).

The new total memory capacity should be shown correctly.

? Is the total amount of memory displayed correctly? If not,

➜ Ensure that the DIMMs were installed correctly.

➜ Ensure that the correct total memory was entered in the printer
driver.
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10 Maintaining the printer

CAUTION

You could damage the unit by using incorrect accessories and parts!
If you use accessories and parts from manufacturers other than MINOL-
TA-QMS, we cannot guarantee that the laser printer will operate properly.

➜ Use only MINOLTA-QMS accessories and parts unless specified oth-
erwise.

WARNING

Toner poses a health hazard!
Toner is harmful if swallowed.

➜ If you swallow toner, consult a doctor immediately.

➜ If you get toner on your hands, wash them immediately with cold water
and soap.
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10 Maintaining the printer
10.1 Replacing the toner cartridge
Replace the toner cartridge when it is empty or when the printed docu-
ments are too light.

Two toner cartridges are available:

� The regular toner cartridge has a capacity of about 3000 letter/A4 pag-
es at about 5% toner coverage.

� The high-capacity toner cartridge has a capacity of about 6000 letter/
A4 pages at about 5% toner coverage.

✎
Note:
The toner cartridge that comes with the printer has a capacity of about
1500 letter/A4 pages at about 5% toner coverage.

WARNING

The fusing unit can become very hot!
The fusing unit, which is located beneath the top cover, can become very
hot when the printer is in operation.

➜ To prevent injuries, avoid contact with this area.

Fusing unit
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✎
What precautions should I take
when handling the toner car-
tridge?
Never touch the developing roller
under the flap; otherwise, print qual-
ity may decline.

1 Turn off the printer and disconnect the power cord from the printer.

2 Close the face-down tray.

3 Press the top cover release button
and open the top cover.

4 Remove the old toner cartridge.
10-3EDNord - Istedgade 37A - 9000 Aalborg - telefon 96333500



10 Maintaining the printer
5 Press in the marked positions of the
handle to fold down the handle.

❍ Dispose of the used toner car-
tridge properly.

6 Remove the new toner cartridge
from its package.

7 Holding it firmly with both hands,
rock the toner cartridge left and
right, forward and backward, to dis-
tribute the toner evenly.

8 Completely remove the protective
seal from the toner cartridge, and
then raise up the handle.

9 Holding the handle, lower the toner
cartridge into the printer, aligning
the four pins (two on each side) with
the grooves inside the printer.

❍ Color coordinated “2” labels
have been affixed to the toner
cartridge and to the inside of the
printer. Install the toner cartridge
by aligning these labels.
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❍ The toner cartridge clicks into

place when it is completely in-
stalled.

10 Close the top cover and press it
down gently but firmly until it locks
into place.

Resetting the counter for the toner cartridge

After you have replaced the toner cartridge, reset the counter for the toner
cartridge.

✎
The counter can also be reset via the Counter tab in the Printer
Control Panel!
See chapter 6 or the Printer Control Panel’s online help.

1 Turn off the printer.
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10 Maintaining the printer
2 While holding down the panel button, turn on the printer.

The green “Ready” indicator begins to blink.

3 Continue holding down the panel button, and the green “Ready” indi-
cator starts to blink.

4 After the green “Ready” indicator has blinked for about 5 seconds, re-
lease the panel button.

Both indicators begin to blink.

5 After confirming that both indicators are blinking, press and hold down
the panel button again for at least 5 seconds.

Both indicators light up for about 5 seconds, and then both indicators
begin to blink again.

The counter for the toner cartridge has now been reset.

6 Turn the printer off and then on again.

Once the green “Ready” indicator remains on, the printer is again in
Stand-by mode.
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10.2 Replacing the drum cartridge
Change the drum cartridge when the printed documents become faint or
blurred.

The drum cartridge has a capacity of about 16,000 (one-page jobs) to
20,000 (continuous printing) letter/A4 pages (at an average of 5% or less
coverage).

WARNING

The fusing unit can become very hot!
The fusing unit, which is located beneath the top cover, can become very
hot when the printer is in operation.

➜ To prevent injuries, avoid contact with this area.

✎
What precautions should I take
when handling the drum car-
tridge?
Never touch the drum under the
flap; otherwise, print quality may de-
cline.

1 Turn off the printer and disconnect the power cord.

2 Close the face-down tray.

Fusing unit
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3 Press the top cover release button
and open the top cover.

4 Remove the toner cartridge and the
old drum cartridge.

5 Remove the new drum cartridge from its carton.
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6 Install the drum cartridge in the

printer, aligning the guides of the
cartridge with the grooves inside the
printer.

❍ Color coordinated “1” labels
have been affixed to the drum
cartridge and to the inside of the
printer. Install the drum cartridge
by aligning these labels.

7 Place the toner cartridge back into
the printer, aligning the four pins
(two on each side) with the grooves
inside the printer.

❍ Color coordinated “2” labels
have been affixed to the toner
cartridge and to the inside of the
printer. Install the toner cartridge
by aligning these labels.

❍ The toner cartridge clicks into
place when it is completely in-
stalled.
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8 Close the top cover and press it
down gently but firmly until it locks
into place.

Resetting the counter for the drum cartridge

After you have replaced the drum cartridge, reset the drum cartridge
counter.

✎
The counter can also be reset via the Counter tab in the Printer
Control Panel!
See chapter 6 or the Printer Control Panel’s online help.

1 Turn off the printer.

2 While holding down the panel button, turn on the printer.

The green “Ready” indicator begins to blink.

3 Continue holding down the panel button, and the green “Ready” indi-
cator starts to blink.

4 After the green “Ready” indicator has blinked for about 5 seconds, re-
lease the panel button.

Both indicators begin to blink.

5 After confirming that both indicators are blinking, briefly press the pan-
el button.

Both indicators light up for about 5 seconds, and then both indicators
begin to blink.

The counter for the drum cartridge has now been reset.

6 Turn the printer off and then on again.

Once the green “Ready” indicator remains on, the printer is again in
Stand-by mode.
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10.3 Cleaning the printer
Clean the printer at regular intervals to prevent dust, dirt ,and paper resi-
due from accumulating in and on the printer.

Cleaning the outside of the printer

1 Turn off the printer and disconnect the power cord.

2 Wipe the outside of the printer with a soft cloth. You may moisten the
cloth with a little neutral household cleaner.

Cleaning the paper feed roller

Clean the paper feed roller if media feed problems occur frequently.

WARNING

The fusing unit can become very hot!
The fusing unit, which is located beneath the top cover, can become very
hot when the printer is in operation.

➜ To prevent injuries, avoid contact with this area.

➜ After turning off the printer, wait at least 10 minutes before cleaning the
inside of the printer.

1 Turn off the printer and disconnect the power cord.

2 Close the face-down tray.

Fusing unit
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3 Press the top cover release button
and open the top cover.

4 Remove the toner cartridge and the
drum cartridge.

Wrap the drum cartridge with a cloth
to protect it from exposure to light.

5 Wipe the paper feed roller with a
soft, dry cloth.
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6 Reinstall the drum cartridge and the

toner cartridge.

7 Close the top cover and press it
down gently but firmly until it locks
into place.
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11 Troubleshooting

WARNING

The fusing unit can become very hot!
The fusing unit, which is located beneath the top cover, can become very
hot when the printer is in operation.

➜ To prevent injuries, avoid contact with this area.

Fusing unit
11-1EDNord - Istedgade 37A - 9000 Aalborg - telefon 96333500



11 Troubleshooting
11.1 Clearing media jams

Clearing a media jam inside the printer

1 Turn off the printer.

2 Close the face-down tray.

3 Press the top cover release button,
and then open the top cover.

4 Remove the toner cartridge and the
drum cartridge.
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5 Carefully pull the misfed media out

of the printer.

❍ If paper is misfed at the fusing
unit, grasp the bottom of the pa-
per and pull it out.

6 Reinstall the drum cartridge.

7 Reinstall the toner cartridge.

8 Close the top cover, and then open the face-down tray.

❍ Printing automatically restarts from the page that was misfed.
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Clearing a media jam in the output tray

1 Carefully pull the misfed media out
of the tray.

2 Open the top cover and close it again in order to reset the printer.
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Clearing a media jam at Tray 1

1 Remove the tray cover and any me-
dia in Tray 1.

2 Carefully pull the misfed media out
of Tray 1.

3 Reload the media in Tray 1, and replace the tray cover.

❍ Do not reload curled or wrinkled media.

4 Reinstall Tray 1 in the printer.

5 Close the face-down tray, and then open the top cover.

6 Remove any pieces of media that may have torn off or are remaining
in the printer.

7 Close the top cover, and then open the face-down tray.

8 Open the top cover and close it again in order to reset the printer.

❍ Printing automatically restarts from the page that was misfed.
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Clearing a media jam in the manual feed tray

1 Remove the Tray 1 cover and the
plate at the inlet of the manual feed
tray.

2 Remove the misfed media.

3 Reinstall the plate at the inlet of the
manual feed tray and the Tray 1
cover.
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Clearing a media jam in the lower feeder unit (Tray 2)

1 Slide the tray out of the lower feeder
unit.

2 Remove any folded or misfed media
from the inside of the lower feeder
unit.

3 Remove the tray cover and any media in the tray.

4 Carefully pull the misfed media out of the tray.

5 Reload the media in the tray.

❍ Make sure the paper is evenly
aligned and that the top sheet is
below the maximum paper
mark.

❍ Do not reload curled or wrinkled
media.

6 Replace the tray cover and insert the tray into the lower feeder unit.

7 Open the printer’s top cover and close it again in order to reset the
printer.

❍ Printing automatically restarts from the page that was misfed.
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11.2 General printing problems

✎
Further information and assistance...
can be found on the Internet at www.minolta-qms.com/support

11.3 Print quality problems
If you are having problems with print quality, follow these steps:

� Remove the toner cartridge and shake it back and forth carefully to dis-
tribute the remaining toner evenly.

� Remove the toner cartridge and check it for damage. If necessary, re-
place it with a new cartridge. (See chapter 10.)

� Remove the drum cartridge and check it for damage. If necessary, re-
place it with a new cartridge. (See chapter 10.)

� Clean the inside of the printer. (See chapter 10.)

� Deactivate the Toner Save feature in the printer driver. (See
chapter 4.)

Problem Possible cause Action

No output The printer is not connected to
the power supply, or the cable is
not connected to the printer.

Check the power connection and
the interface connection to the
printer.

The printer is not turned on. Turn on the printer.

You are using the wrong type of
interface cable.

Check whether the interface
cable type conforms to the
specifications (see chapter 12).

The computer’s communication
port settings are not correct for
your printer.

Check the computer’s
communication port settings.
Refer to the documentation that
comes with your computer and
check if its current
communication port settings are
correct.

The parallel port on your
computer is also being used for
other equipment (for example, a
scanner or ZIP drive).

Disconnect the other equipment
and operate the printer via this
port.
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Problem Possible cause Action

Blank pages The toner cartridge is empty or
damaged.

Remove the toner cartridge and
check it for damage. If
necessary, replace the toner
cartridge. (See chapter 10.)

Black pages The toner cartridge is damaged. Remove the toner cartridge and
check it for damage. If
necessary, replace the toner
cartridge. (See chapter 10.)

Pages are too light The Toner Save mode has been
activated.

Check the setting in the printer
driver. Change the setting and
try printing again. (See chapter
4.)

The toner density is not set
correctly in the printer driver.

Set the toner density to the
desired level and try printing
again. (See chapter 4.)

The toner cartridge may be
running out of toner.

Remove the toner cartridge and
rock it in order to improve the
distribution of the remaining
toner. If the problem persists,
replace the toner cartridge. (See
chapter 10.)

The toner cartridge is damaged. Remove the toner cartridge and
check it for damage. If
necessary, replace the toner
cartridge. (See chapter 10.)
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Pages are too dark The toner cartridge is damaged. Remove the toner cartridge and
check it for damage. If
necessary, replace the toner
cartridge. (See chapter 10.)

The toner density is not set
correctly in the printer driver.

Set the toner density to the
desired level. (See chapter 4.)

Blurred
background

The toner cartridge is damaged. Remove the toner cartridge and
check it for damage. If
necessary, replace the toner
cartridge. (See chapter 10.)

Uneven toner
density

The toner cartridge is damaged. Remove the toner cartridge and
check it for damage. If
necessary, replace the toner
cartridge. (See chapter 10.)

The drum cartridge is damaged. Remove the toner cartridge and
check it for damage. If
necessary, replace the drum
cartridge. (See chapter 10.)

The toner may be unevenly
distributed inside the toner
cartridge.

Remove the toner cartridge and
rock it in order to improve the
distribution of the remaining
toner. If the problem persists,
replace the toner cartridge. (See
chapter 10.)

Blank spots, text
missing

The paper is moist because of
high humidity in the air or from
being splashed with water.

Replace the paper you are using
with dry paper and try printing
again.

Problem Possible cause Action
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11.4 Printer messages

Indicator functions

The control panel has two indicators
and one button. The control panel in-
dicators provide information on the
status of the printer.

The indicators have five types of sig-
nals:

� Off

� On

� Slow blinking—1 blink every 2 seconds

� Blinking—1 blink per second

� Rapid blinking—2 blinks per second

White or black lines The toner cartridge is damaged
(white lines).

The drum cartridge is damaged
(black lines).

Remove the toner cartridge/
drum cartridge and check it for
damage.
If necessary, replace the toner
cartridge/drum cartridge.

Toner smudges The toner cartridge is damaged. Remove the toner cartridge and
check it for damage. If
necessary, replace the toner
cartridge. (See chapter 10.)

The toner may be unevenly
distributed inside the toner
cartridge.

Remove the toner cartridge and
rock it in order to improve the
distribution of the remaining
toner. If the problem persists,
replace the toner cartridge. (See
chapter 10.)

The paper feed roller is dirty. Clean the paper feed roller. (See
chapter 10.)

Problem Possible cause Action

No. Description

1 Error indicator (orange)

2 Ready indicator (green)

3 Panel button

1

2

3
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Status messages

Status messages indicate the current condition of the printer.

Error messages

These messages indicate errors which you must correct before a print job
can continue or the printer status returned to “Ready.”

Ready indicator
(green)

Error indicator
(orange)

Printer condition Action

Off Off Off None

On Off Ready to print None

Rapid blinking Off Warming up None

Blinking Off Receiving data None

Processing data

Printing

On On Initializing None

Cancelling a print job

Resetting a counter

Slow blinking Off Power save mode None

Rapid blinking Rapid blinking Reset mode None

Demo page/Configuration page
select mode

Ready indicator
(green)

Error indicator
(orange)

Printer condition Action

Blinking Blinking Memory overflow or print
job is too complex.

If the “Auto Continue”
function has been
activated in the printer
tools, the sheet already
fed in is automatically
ejected after a
predetermined time. (See
chapter 6.)

Expand the printer’s
memory capacity
(DIMMs) or reduce the
size of the print job.
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Troubleshooting 11
Service message

This message indicates a serious fault that can be corrected only by an
authorized service technician. If this message is signalled, turn the printer
off and then on again. If the problem persists, contact your vendor or au-
thorized service provider.

Rapid blinking alternately No media in the tray
specified in the printer
driver.

Load media into the
appropriate tray.

Paper size error Load paper with the
appropriate size into the
paper feed tray.

Waiting for paper to be
loaded into Tray 1 during
manual duplex printing.

Correctly load paper
printed on one side, with
the blank side facing up,
into Tray 1. (Note: You
cannot duplex from the
manual feed tray.)

Off Slow blinking Tray empty Load media into the
appropriate tray.

Off Blinking Media jam Clear the jam and then
continue with the print job.

Off On Top cover is open Close the top cover

Ready indicator
(green)

Error indicator
(orange)

Condition Action

Off Rapid blinking Fatal error Turn the printer off, then
on again. If the problem
persists, contact your
technical customer
service.

Ready indicator
(green)

Error indicator
(orange)

Printer condition Action
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Specifications 12
12 Specifications

12.1 Safety specifications

12.2 Technical specifications

✎
To check on the availability of third-party options, such as an
Ethernet network adapter...
go to www.minolta-qms.com/products

Printer

Printer

Safety standards U.S. model: UL 60950, CSA C22.2 No. 60950
European model: EU Directive 73/23/EEC

EN 60950 (IEC 60950)
China model: GB 4943

EMC standards U.S. model: FCC part 15 subpart B class B
ICES-003

European model: EU Directive 89/336/EEC
EN 55022 (CISPR Pub. 22) class B
EN 61000-3-2
EN 61000-3-3

China model: GB 9254 class B
Australian model: AS/NZS 3548 class B

Type Desktop laser beam printer

Print system Electrostatic dry powder imaging system

Exposure system Laser diode + polygon mirror scanning

Developing system Electrophotographic printing system

Resolution 1200 dpi × 1200 dpi (at half speed),
600 dpi × 600 dpi

Rasterize method PCL 6 and PostScript Level 2 emulation

Print speed 600 dpi: 16 pages per minute (Letter/A4)
1200 dpi:8 pages per minute (Letter/A4)

First print 600 dpi: Within 15 seconds (Letter/A4)
1200 dpi:Within 24 seconds (Letter/A4)

Warm-up time 7 seconds or less

Media sizes • Paper—Letter, Legal, Executive, Half Letter, A4, A5, B5 JIS,
Chinese 16K, Chinese 32K, custom paper sizes

• Envelopes—Commercial 10, Monarch, DL, C5, C6, B5,
Choukei-3Gou and Choukei-4Gou

• Postcard
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12 Specifications
Lower feeder unit (option)

Paper/Media • Plain paper (16 to 24 lbs; 60 to 90 g/m2)
• Transparencies
• Envelopes
• Thick paper (24 to 43 lbs; 90 to 163 g/m2)
• Postcard

Paper feeding • Tray 1 (Universal tray)
• Manual feed tray
• Lower feeder unit (Tray 2) (Option)

Input capacity • Tray 1 (Universal tray): 250 sheets
• Manual feed tray: 1 sheet
• Lower feeder unit (Option): 500 sheets

Output capacity • Face-down tray: 100 sheets
• Face-up tray (Option): 20 sheets

Operating temperature 50° to 95°F (10° to 35°C)
(with fluctuation of 18°F (10°C) per hour)

Operating humidity 15 to 85 % (with fluctuation of 20% per hour)

Drum cartridge 20,000 Letter/A4-size prints with a black-to-white ratio of 5% or
more.

Toner cartridge 6,000 (type 1) or 3,000 (type 2) Letter/A4-size prints with a
black-to-white ratio of 5% or more.
The enclosed cartridge is for 1,500 prints.

Power supply 110-127V, 50-60Hz
220-240V, 50-60Hz

Power consumption 120V: 840W or less
220-240V: 850W or less

Amperage 120V: 7.2A or less
220-240V: 3.8A or less

External dimensions (with
the face-down tray closed)

Height:10.2" (259 mm)
Width: 15.3" (389 mm)
Depth: 17.4" (441 mm)

Weight Printer: approximately 3.2 lbs (7 kg)
Drum cartridge: approximately 0.1 lbs (0.3 kg)
Toner cartridge: approximately 0.2 lbs (0.5 kg)

Interface IEEE 1284 Parallel (Compatible/Nibble/ECP)
USB (Revision 1.1 compliant)

CPU Destiny ASIC D8401 75MHz

Standard memory 16 MB (expandable up to 144 MB)

Options • Lower feeder unit (Tray 2)
• Legal and executive/B5 JIS trays for the lower feeder unit
• Face-up tray
• Expansion memory (SDRAM-DIMM)

Paper tray Standard tray: Letter or A4
Optional trays: Legal and executive/B5 JIS

Paper/Media Plain paper (16–24 lbs; 60–90 g/m2)

Capacity Up to 500 sheets
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SDRAM-DIMM expansion memory (option)

Parallel interface connectors and cables

USB interface connectors and cables

CAUTION

Danger of fire from cable!
➜ MINOLTA-QMS undertakes no guarantee for any specific cable. The

user is responsible for the quality and performance of the cable.

External dimensions
(without paper cassette)

Height:5.2" (132 mm)
Width: 15.0" (382 mm)
Depth: 12.0" (305 mm)

Weight Approximately 1.8 lbs (4 kg)

Capacity 64, 128 MB

Function type Burst mode

CAS Latency 2 or 3

ECC None (Usable even with ECC)

Access speed 10 ns

Number of pins 168

Module type SDRAM-DIMM (Double In-line Memory Module)

Operating voltage 3.3 V

Connectors Printer: Parallel 36-pin connector
Computer: EIA 25-pin connector

Cable type Shielded
Each signal and earth pair should be twisted

Pin assignments IEEE 1284, type-B connector

Connectors Printer: Series B plug
Computer: Series A plug

Cable type Require twisted data conductors or a shielded

Pin assignments 1: VBUS
2: D+
3: D-
4: GND
Shell: Shield
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12 Specifications
12.3 Our concern for environmental protection

As an ENERGY STAR® Partner, we have determined that this machine
meets the ENERGY STAR® Guidelines for energy efficiency.

What is an ENERGY STAR® product?

An ENERGY STAR® product has a special feature that allows it to auto-
matically switch to a “low-power mode” after a period of inactivity. An EN-
ERGY STAR® product uses energy more efficiently, saves you money on
utility bills and helps protect the environment.
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12.4 FCC Part 15 - Radio Frequency Devices

For US Users

NOTE: This equipment has been tested and found to comply with the lim-
its for a Class B digital device, pursuant to Part 15 of the FCC Rules.
These limits are designed to provide reasonable protection against harm-
ful interference in a residential installation. This equipment generates,
uses and can radiate radio frequency energy and, if not installed and used
in accordance with the instructions, may cause harmful interference to ra-
dio communications. However, there is no guarantee that interference will
not occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct
the interface by one or more of the following measures:

� Reorient or relocate the receiving antenna.

� Increase the separation between the equipment and the receiver.

� Connect the equipment into an outlet on a circuit different from that to
which the receiver is connected.

� Consult the dealer or an experienced radio/TV technician for help.

WARNING: The design and production of this unit conform to FCC regu-
lations, and any changes or modifications must be registered with the
FCC and are subject to FCC control. Any changes made by the purchaser
or user without first contacting the manufacturer will be subject to penalty
under FCC regulations.

This device must be used with a shielded parallel interface cable and
shielded USB interface cable.

The use of non-shielded cables is likely to result in interference with radio
communications and is prohibited under FCC rules.

FCC: Declaration of Conformity

Product Type Laser Beam Printer

Product Name PagePro 1250E

Options • Lower feeder unit (4198)
• Face-up Tray
• Expansion Memory

This device complies with Part 15 of the FCC Rules
Operation is subject to the following two conditions:
• This device may not cause harmful interference, and this device must accept any

interference received, including interference that may cause undesired operation.
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12.5 Interference-Causing Equipment Standard (ICES-
003 ISSUE 3)

For Canadian users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003
du Canada.

12.6 CE Marking (Declaration of Conformity)

For European users

This product complies with the following EU directives: 89/336/EEC,
73/23/EEC, and 93/68/EEC directives.

This declaration is valid for the area of the European Union (EU) only.

This device must be used with a shielded parallel interface cable and
shielded USB interface cable. The use of non-shielded cables is likely to
result in interference with radio communications and is prohibited under
89/336/EEC rules.

12.7 CISPR 22 and local rules
This device must be used with a shielded parallel interface cable and
shielded USB interface cable.
The use of non-shielded cables is likely to result in interference with radio
communications and is prohibited under CISPR 22 and local rules.

12.8 Acoustic Noise
Machine Noise Regulation 3 GSGV, 18.01.1991: The sound pressure lev-
el at the operator position according to EN27779 is equal to or less than
70dB (A).
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12.9 Safety information
This section contains detailed instructions on the operation and mainte-
nance of this machine. To achieve optimum utility of this device, all oper-
ators should carefully read and follow the instructions in this manual.
Please keep this manual in a handy place near the machine.

* Note that some parts of the contents of this section may not correspond with the purchased
product.

Warning and precaution symbols

Meaning of symbols

Please read the next section before using this device. It contains important information
related to user safety and preventing equipment problems.

Make sure you observe all of the precautions listed in this manual.

Ignoring this warning could cause serious injury or even
death.

Ignoring this caution could cause injury or damage to
property.

WARNING

CAUTION

A triangle indicates a danger against which you should take precaution.

This symbol warns against cause burn.

A diagonal line indicates a prohibited course of action.

This symbol warns against dismantling the device.

A black circle indicates an imperative course of action.

This symbol indicates you must unplug the device.
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WARNING

• Do not modify this product, as a fire, electrical shock, or breakdown could
result. If the product employs a laser, the laser beam source could cause
blindness.

• Do not attempt to remove the covers and panels which have been fixed to
the product. Some products have a high-voltage part or a laser beam
source inside that could cause an electrical shock or blindness.

• Only use the power cord supplied in the package. Failure to use this cord
could result in a fire or electrical shock.

• Use only the specified power source voltage. Failure to do that could result
in a fire or electrical shock.

• Do not use a multiple outlet adapter to connect any other appliances or
machines. Use of a power outlet for more than the marked current value
could result in a fire or electrical shock.

• Do not unplug and plug in the power cord with a wet hand, as an electrical
shock could result.

• Plug the power cord all the way into the power outlet. Failure to do this
could result in a fire or electrical shock.

• Do not scratch, abrade, place a heavy object on, heat, twist, bend, pull on,
or damage the power cord. Use of a damaged power cord (exposed core
wire, broken wire, etc.) could result in a fire or breakdown.
Should any of these conditions be found, immediately turn OFF the power
switch, unplug the power cord from the power outlet, and then call your
authorized service representative.

• In principle, do not use an extension cord. Use of an extension cord could
cause a fire or electrical shock. Contact your authorized service
representative if an extension cord is required.

• Do not place a flower vase or other container that contains water, metal
clips or other small metallic objects on this product. Spilled water or metallic
objects dropped inside the product could result in a fire, electrical shock, or
break-down.

• Should a piece of metal, water, or any other similar foreign matter get inside
the product, immediately turn OFF the power switch, unplug the power cord
from the power outlet, and then call your authorized service representative.

• If this product becomes inordinately hot or emits smoke, or unusual odor or
noise, immediately turn OFF the power switch, unplug the power cord from
the power outlet, and then call your authorized service representative. If
you keep on using it as is, a fire or electrical shock could result.

• If this product has been dropped or its cover damaged, immediately turn
OFF the power switch, unplug the power cord from the power outlet, and
then call your authorized service representative. If you keep on using it as
is, a fire or electrical shock could result.

• Do not throw the toner cartridge or toner into an open flame. The hot toner
may scatter and cause burns or other damage.

• Connect the power cord to an electrical outlet that is equipped with a
grounding terminal.
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CAUTION

• Do not use flammable sprays, liquids, or gases near this product, as a fire
could result.

• Do not leave a toner unit or drum unit in a place within easy reach of
children. Licking or ingesting any of these things could injure your health.

• Do not let any object plug the ventilation holes of this product. Heat could
accumulate inside the product, resulting in a fire or malfunction.

• Do not install this product at a site that is exposed to direct sunlight, or near
an air conditioner or heating apparatus. The resultant temperature changes
inside the product could cause a malfunction, fire, or electrical shock.

• Do not place the product in a dusty place, or a site exposed to soot or
steam, near a kitchen table, bath, or a humidifier. A fire, electrical shock, or
breakdown could result.

• Do not place this product on an unstable or tilted bench, or in a location
subject to a lot of vibration and shock. It could drop or fall, causing personal
injury or mechanical breakdown.

• After installing this product, mount it on a secure base. If the unit moves or
falls, it may cause personal injury.

• Do not store toner units and PC drum units near a floppy disk or watch that
are susceptible to magnetism. They could cause these products to
malfunction.

• Do not place any objects around the power plug as the power plug may be
difficult to pull out when an emergency occurs.

• Do not touch the electrical contacts that are located inside the top cover
and underneath the cartridge as an electrostatic discharge may damage
the printer.

• The inside of this product has areas subject to high temperature, which may
cause burns. When checking the inside of the unit for malfunctions such as
a paper misfeed, do not touch the locations (around the fusing unit, etc.)
which are indicated by a “Caution! High Temperature!” warning label.

• The socket-outlet shall be installed near the machine and shall be easily
accessible as the power plug may be difficult to pull out when an
emergency occurs.

• Always use this product in a well ventilated location. Operating the product
in a poorly ventilated room for an extended period of time could injure your
health. Ventilate the room at regular intervals.

• Whenever moving this product, be sure to disconnect the power cord and
other cables. Failure to do this could damage the cord or cable, resulting in
a fire, electrical shock, or breakdown.

• When moving this product, always hold it by the locations specified in the
user manual or other documents. If the unit falls it may cause severe
personal injury. The product may also be damaged or malfunction.

• Remove the power plug from the outlet more than one time a year and
clean the area between the plug terminals. Dust that accumulates between
the plug terminals may cause a fire.

• When unplugging the power cord, be sure to hold onto the plug. Pulling on
the power cord could damage the cord, resulting in a fire or electrical shock.
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12.10 Working safely with your laser printer

Notes on your safety and operating safety

Working improperly with the printer can result in health hazards, electric
shocks and even fires. Before you unpack the laser printer, you should
make yourself familiar with this information on your safety and operating
safety.

CAUTION

Observe the following information:
➜ Make sure that the power cord is correctly plugged into the socket and

that the socket is at all times visible and readily accessible.

➜ Do not pull on the cord to pull the power plug out of the socket as this
may damage the cord. The result could be an electric shock or a fire.

➜ Remove the power plug from the socket if the machine will not be in
use for an extended period of time.

➜ Do not remove the power cord from the socket with wet hands as this
may result in an electric shock.

➜ Do not move the unit unless the power cord has been removed from
the socket. Otherwise you may damage the cord. The result could be
a short-circuit or a fire.

➜ Do not place any heavy objects on the power cord. Do not pull or kink
the cord as this can result in damage to the cord. The result could be
an electric shock or a fire.

➜ Make sure that the machine is not standing on a cord to another ma-
chine as this can result in damage to that cord. The result could be a
fire or improper functioning of the unit in question.

➜ Make sure that the power supply to the unit has the correct voltage.
Otherwise the result could be a fire or an electric shock.

➜ Switch off the unit immediately and unplug the power cord if the power
supply cord is damaged. Failure to do so could result in a fire or an
electric shock. Inform your customer support technical specialist.

➜ Use only extension cords that are designed for at least the maximum
power rating of the machine. Extension cords with lower ratings can
result in the unit overheating and can even lead to a fire.

➜ Perform only the procedures that are described in this manual. Using
the machine improperly can result in a fire or an electric shock.
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➜ Do not place any heavy objects on the machine.

➜ Do not open any covers on the machine while printing is in progress.

➜ Do not switch off the unit while printing is in progress.

➜ Do not place any magnetic objects near the machine.

➜ Do not use any flammable sprays, liquids or gases in the vicinity of the
machine.

➜ Do not remove any safety devices and do not alter the construction of
the machine. The unit is equipped with high-voltage components. Us-
ing the machine improperly can result in a fire or an electric shock.

➜ Do not insert any paper clips, staples or other small metal objects into
openings on the machine. The result could be an electric shock or a
fire. If metal pieces are fed into the machine, switch it off immediately,
disconnect the power cord and inform your customer support technical
specialist.

➜ Do not place coffee cups, drink bottles, or other containers with liquids
in them on the machine. If liquid enters the machine, the result could
be an electric shock or a fire. If liquid does get into the machine, switch
it off immediately, disconnect the power cord and inform your custom-
er support technical specialist.

➜ If the machine becomes unusually hot, or if you notice smoke or an un-
usual odor coming from the machine, switch it off immediately and re-
move the power cord from the socket. Inform your customer support
technical specialist.
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Laser safety

This is a page printer which operates by means of a laser. There is no pos-
sibility of danger from the laser, provided the printer is operated according
to the instructions in this manual.

Since radiation emitted by the laser is completely confined within protec-
tive housing, the laser beam cannot escape from the machine during any
phase of user operation.

Internal laser radiation

Maximum average radiation power: 35 µ W at the laser aperture of the
print head unit.

Wavelength: 770-795 nm

This product employs a Class 3b laser diode that emits an invisible laser
beam. The laser diode and the scanning polygon mirror are incorporated
in the print head unit.

The print head unit is NOT A FIELD SERVICEABLE ITEM. Therefore, the
print head unit should not be opened under any circumstances.

Laser caution label

A laser caution label is attached inside the machine as shown below.
Do not dispose of the printer or consumables other than directed in the
manual. This product has a laser beam source inside that could cause
blindness if the safeguard is damaged.

The above figure shows the internal view of the printer when the top cover
is open.

Laser aperture of the
print head unit
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Laser safety label

A laser safety label is attached to the outside of the machine as shown be-
low.

For United States users

CDRH Regulations

This machine is certified as a Class 1 Laser product under the Radiation
Performance Standard according to the Food, Drug and Cosmetic Act of
1990. Compliance is mandatory for Laser products marketed in the United
States and is reported to the Center for Devices and Radiological Health
(CDRH) of the US Food and Drug Administration of the US Department of
Health and Human Services (DHHS). This means that this device does
not produce hazardous laser radiation. The label shown above indicates
compliance with the CDRH regulations and must be attached to laser
products marketed in the United States.

CAUTION

Use of controls, adjustments or performance of procedures other than
those specified in this manual may result in hazardous radiation exposure.

This is a semiconductor laser. The maximum power of the laser diode is
5 mW and the wavelength is 770-795 nm.

110-127 V area:

THIS PRODUCT WITH 21 CFR

CHAPTER I, SUBCHAPTER J

220 V area:

CLASS 1 LASER PRODUCT
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For users in all countries

CAUTION

Use of controls, adjustments or performance of procedures other than
those specified in this manual may result in hazardous radiation exposure.

This machine is certified as a Class 1 laser product. This means that the
machine does not produce hazardous laser radiation.

This is a semiconductor laser. The maximum power of the laser diode is
5 mW and the wavelength is 770-795 nm.

For Denmark users

ADVARSEL
Usynlig laserstråling ved åbning, når sikkerhedsafbrydere er ude af funk-
tion. Undgå udsættelse for stråling.

Klasse 1 laser produkt der opfylder IEC60825 sikkerheds kravene.

Dansk: Dette er en halvlederlaser. Laserdiodens højeste styrke er 5 mW
og bølgelængden er 770-795 nm.

For Norway users

ADVERSEL
Dersom apparatet brukes på annen måte enn spesifisert i denne bruksan-
visning, kan brukeren utsettes for unsynlig laserstråling som overskrider
grensen for laser klass 1.

Dette en halvleder laser. Maksimal effekt till laserdiode er 5 mW og bølge-
lengde er 770-795 nm.

For Finland, Sweden users

LOUKAN 1 LASERLAITE
KLASS 1 LASER APPARAT

VAROITUS!
Laitteen käyttäminen muulla kuin tässä käyttöohjeessa mainitulla tavalla
saattaa altistaa käyttäjän turvallisuusluokan 1 ylittävälle näkymättömälle
lasersäteilylle.

Tämä on puolijohdelaser. Laserdiodin suurin teho on 5 mW ja aallonpituus
on 770 – 795 nm.
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VARNING!
Om apparaten används på annat sätt än i denna bruksanvisning specifi-
cerats, kan användaren utsättas för osynlig laserstrålning, som överskrid-
er gränsen för laserklass 1.

Det här är en halvledarlaser. Den maximala effekten för laserdioden är 5
mW och våglängden är 770 – 795 nm.

VARO!
Avattaessa ja suojalukitus ohitettaessa olet alttiina näkymättömälle laser-
säteilylle. Älä katso säteeseen.

VARNING!
Osynlig laserstrålning när denna del är öppnad och spärren är urkopplad.
Betrakta ej strålen.

Ozone release

During printer operation, a small quantity of ozone is released. This
amount is not large enough to harm anyone adversely. However, be sure
the room where the machine is being used has adequate ventilation, es-
pecially if you are printing a high volume of materials, or if the machine is
being used continuously over a long period.

Dégagement d’ozone

L’imprimante dégage une faible quantité d’ozone durant son utilisation.
Cette quantité n’est pas suffisamment importante pour être dangereuse.
Cependant, veillez à ce que la pièce dans laquelle la machine soit
adéquatement ventilée, surtout en cas d’impression de gros volumes ou
en cas d’utilisation continue pendant un laps de temps très long.
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